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คู่มือการจัดส่งรายงานคู่มือการจัดส่งรายงาน

กองพัฒนาระบบการประเมินผลกระทบสิ่งแวดล้อม
สำนักงานนโยบายและแผนทรัพยากรธรรมชาติและสิ่งแวดล้อม



กลุ่มงานวิชาการและฐานข้อมูล
กองพัฒนาระบบการประเมินผลกระทบสิ่งแวดล้อม
สำนักงานนโยบายและแผนทรัพยากรธรรมชาติและ
สิ่งแวดล้อม
กุมภาพันธ์ 2568

บทนำ
 คู่มือการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม (e-Report) นี้ จัดทำขึ้น

เพื่อใช้ประกอบการดำเนินงานตามประกาศสำนักงานนโยบายและแผนทรัพยากรธรรมชาติ
และสิ่งแวดล้อม เรื่ อง แนวทางการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม 
พ.ศ. 2568 โดยเป็นการสรุปภาพรวมของประกาศดังกล่าว ขั้นตอนและวิธีการสร้างรายงาน
ในรูปแบบอิเล็กทรอนิกส์ รวมทั้งการป้องกันการแก้ไขไฟล์อิเล็กทรอนิกส์ พร้อมอธิบาย
รายละเอียดหรือข้อควรระวังที่จำเป็นต่อการดำเนินงาน โดยหวังเป็นอย่างยิ่งว่า คู่มือฉบับนี้
จะเป็นประโยชน์ต่อผู้จัดทำรายงานและผู้เกี่ยวข้อง ในการเสริมสร้างความรู้ ความเข้าใจ
ต่อการปฏิบัติตามประกาศสำนักงานนโยบายและแผนทรัพยากรธรรมชาติและสิ่งแวดล้อม
เรื่อง แนวทางการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม พ.ศ. 2568 ได้อย่าง
ชัดเจนและถูกต้องมากยิ่งขึ้น
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1.1   ความเป็นมาและสาระสำคัญในการปรับปรุงประกาศฯ
1.2   สรุปแนวทางการจัดส่งรายงาน
1.3   แผนผังสรุปการส่งรายงานในแต่ละขั้นตอน

ภาพรวมประกาศสำนักงานนโยบายและแผนทรัพยากรธรรมชาติ
และสิ่งแวดล้อม เรื่อง แนวทางการจัดส่งรายงานการประเมินผล
กระทบสิ่งแวดล้อม พ.ศ. 2568

ขั้นตอนและวิธีการสร้างรายงานในรูปแบบอิเล็กทรอนิกส์

2.1   4 องค์ประกอบหลักของรายงานในรูปแบบอิเล็กทรอนิกส์   
        (e-Report)
2.2  ขั้นตอนการสร้างลิงก์ในโปรแกรม Word
2.3  ขั้นตอนการสร้างลิงก์ในโปรแกรม  Adobe Acrobat Pro
2.4  ขั้นตอนการสร้างลิงก์ในโปรแกรม PDF อื่น ๆ หรือ
        เครื่องมือออนไลน์
2.5  การป้องกันการแก้ไขไฟล์ PDF
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หน้า 1

เรื่อง แนวทางการจัดส่งรายงานการประเมิน
ผลกระทบสิ่งแวดล้อม พ.ศ. 2568

ประกาศสำนักงานนโยบายและแผน
ทรัพยากรธรรมชาติและสิ่งแวดล้อม

EIA



2

1.1

1.1 กรณีโครงการ กิจการ หรือการดำเนินการของหน่วยงานของรัฐ หรือหน่วยงานของรัฐดำเนินการ
ร่วมกับเอกชนที่ต้องเสนอขอรับความเห็นชอบจากคณะรัฐมนตรี (โครงการรัฐ/รัฐร่วมเอกชน)

ขั้นเสนอคณะกรรมการผู้ชำนาญการ (คชก.) ยกเลิกสำเนารายงานฉบับหลัก 5 ฉบับ
ขั้นเสนอคณะกรรมการสิ่งแวดล้อมแห่งชาติ (กก.วล.) ลดสำเนารายงานฉบับย่อ จาก 22 ฉบับ
เหลือ 1 ฉบับ

1.2 กรณีโครงการ กิจการ หรือการดำเนินการ ที่ต้องได้รับอนุญาตตามกฎหมาย หรือไม่ต้องเสนอ
ขอรับความเห็นชอบจากคณะรัฐมนตรี (โครงการเอกชน)

 ขั้นเสนอคณะกรรมการผู้ชำนาญการ (คชก.) ยกเลิกสำเนารายงานฉบับหลัก 5 ฉบับ 

1 ยกเลิก/ปรับปรุงจำนวนสำเนารายงาน EIA ในแต่ละขั้นตอน

สรุปสาระสำคัญ

หน้า 2

ความเป็นมา
              สำนักงานนโยบายและแผนทรัพยากรธรรมชาติและสิ่งแวดล้อม (สผ.) ได้ออกประกาศ เรื่อง
แนวทางการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม ประกาศ ณ วันที่ 5 เมษายน 2565  เพื่อ
ให้สอดคล้องกับนโยบายของ สผ. ที่มุ่งเน้นการยกระดับระบบการประเมินผลกระทบสิ่งแวดล้อมเข้าสู่
ความเป็นดิจิทัล และต่อมาได้รับข้อเสนอแนะจากคณะกรรมการปรับปรุงกฎหมายเพื่อความสะดวกใน
การประกอบธุรกิจ ให้มีการปรับปรุงแนวทางฯ โดยการลดสำเนารายงาน EIA เพื่ออำนวยความสะดวก
ให้แก่ภาคธุรกิจในกระบวนการประเมินผลกระทบสิ่งแวดล้อม (EIA) สผ. จึงได้มีการปรับปรุงประกาศ
สผ. ในเรื่องดังกล่าว

           ประกาศ สผ. เรื่อง แนวทางการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม  พ.ศ. 2568
เป็นการปรับปรุงประกาศ เรื่อง แนวทางการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม ฉบับลง   
วันที่ 5 เมษายน 2565 โดยมีประเด็นสำคัญดังนี้ 

เพิ่มเติมรายละเอียด

หมายเหตุ กรณีรายงานการประเมินผลกระทบสิ่งแวดล้อมที่อยู่ในอำนาจการพิจารณาของคณะกรรมการ 
ผู้ชำนาญการระดับจังหวัด ยังคงสำเนารายงานฉบับหลัก 1 ฉบับ

2.1 คำนิยามของคณะกรรมการผู้ชำนาญการส่วนกลาง และคณะกรรมการผู้ชำนาญการระดับจังหวัด
เพื่อให้เกิดความชัดเจนในการปฏิบัติ

2.2 ขันตอนการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อมที่อยในอำนาจของคณะกรรมการ   ผ
ผู้ชำนาญการระดับจังหวัด เพื่อให้เกิดความชัดเจนและสอดคล้องกับการปฏิบัติ

2.3 คู่มือการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม เพื่อประกอบการดำเนินงานตามประกาศฯ
และสร้างรายงานในรูปแบบอิเล็กทรอนิกส์ และการป้องกันการแก้ไขไฟล์รายงาน 

2.2 ขั้นตอนการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อมที่อยู่ในอำนาจของคณะกรรมการ

2.4 การคมครองข้อมลส่วนบคคลในรายงานที่จะอัปโหลดตามแนวทางการเปิดเผยข้อมลในรายงาน
การประเมินผลกระทบสิ่งแวดล้อม และรายงานผลการปฏิบัติตามมาตรการที่กำหนดไว้ในรายงานการ
ประเมินผลกระทบสิ่งแวดล้อม สำหรับเผยแพร่ให้ประชาชนเข้าตรวจดูได้ทางระบบอิเล็กทรอนิกส์ 

2.4 การคุ้มครองข้อมูลส่วนบุคคลในรายงานที่จะอัปโหลดตามแนวทางการเปิดเผยข้อมูลในรายงาน

หมายเหตุ กรณีรายงานการประเมินผลกระทบสิ่งแวดล้อมที่อยู่ในอำนาจการพิจารณาของคณะกรรมการ

หมายเหตุ “คณะกรรมการผู้ชำนาญการระดับจังหวัด” หมายความว่า ผู้ที่ได้รับแต่งตั้งจากคณะกรรมการสิ่งแวดล้อมแห่งชาติให้ทำ
หน้าที่พิจารณารายงานการประเมินผลกระทบสิ่งแวดล้อมเป็นการเฉพาะ สำหรับโครงการ กิจการ หรือการดำเนินการในเขตจังหวัด
ที่มีการประกาศกำหนดเขตพื้นที่และมาตรการคุ้มครองสิ่งแวดล้อม และในเขตจังหวัดหรือกรุงเทพมหานครที่มีการกระจายภารกิจ
การพิจารณารายงานการประเมินผลกระทบสิ่งแวดล้อม 



คชก.
ผู้พิจารณา

ขั้นตอนการ
พิจารณา

กรณีโครงการ กิจการ หรือการดำเนินการของหน่วยงานของรัฐหรือหน่วย
งานของรัฐดำเนินการร่วมกับเอกชนที่ต้องเสนอขอรับความเห็นชอบจาก

คณะรัฐมนตรี  (เสนอ คชก. และ กก.วล.)

กรณีโครงการ กิจการ หรือการดำเนินการ ที่ต้องได้รับอนุญาตตาม
กฎหมาย หรือไม่ต้องเสนอขอรับความเห็นชอบจากคณะรัฐมนตรี

(เสนอ คชก. / ไม่ต้องเสนอ กก.วล.)

รูปแบบเอกสาร
รูปแบบไฟล์

อิเล็กทรอนิกส์
ส่งผ่านระบบ 

Smart EIA Plus รูปแบบเอกสาร
รูปแบบไฟล์

อิเล็กทรอนิกส์
ส่งผ่านระบบ

 Smart EIA Plus

คชก. ส่วนกลาง
 
 

ขั้นเสนอ คชก. - ต้นฉบับหลัก 1 ฉบับ
- ต้นฉบับแก้ไขเพิ่มเติม 
1 ฉบับ
- ต้นฉบับย่อ 1 ฉบับ

1 ชุด ประกอบด้วยไฟล์
ดังนี้
- ฉบับหลัก
- ฉบับแก้ไขเพิ่มเติม
- ฉบับย่อ
*การสร้าง eReport ให้
ดำเนินการตามคู่มือการ
จัดส่งรายงาน EIA

กรอกข้อมูลรายงานใน
ระบบ
- ฉบับหลัก
- ฉบับแก้ไขเพิ่มเติม
- ฉบับย่อ (ถ้ามี)
*การกรอกข้อมูลให้
ดำเนินการตามคู่มือการ
ใช้งานระบบ
การจัดส่งรายงาน EIA 
**ไม่ต้องอัปโหลดไฟล์
รายงาน

- ต้นฉบับหลัก 1 ฉบับ
- ต้นฉบับแก้ไขเพิ่มเติม
1 ฉบับ

1 ชุด ประกอบด้วยไฟล์
ดังนี้
- ฉบับหลัก
- ฉบับแก้ไขเพิ่มเติม
*การสร้าง eReport ให้
ดำเนินการตามคู่มือการ
จัดส่งรายงาน EIA

กรอกข้อมูลรายงาน
- ฉบับหลัก
- ฉบับแก้ไขเพิ่มเติม 
*การกรอกข้อมูลให้
ดำเนินการตามคู่มือ
การใช้งานระบบฐาน
ข้อมูลรายงาน EIA
**ไม่ต้องอัปโหลด
ไฟล์รายงาน

ขั้นเสนอ กก.วล. - ต้นฉบับหลัก 1 ฉบับ
- สำเนาฉบับหลัก 
1 ฉบับ
- ต้นฉบับแก้ไขเพิ่มเติม 
1 ฉบับ
- สำเนาฉบับแก้ไขเพิ่ม
เติม 1 ฉบับ
- ต้นฉบับย่อ 1 ฉบับ
- สำเนาฉบับย่อ 
1 ฉบับ

1 ชุด ประกอบด้วยไฟล์
ดังนี้
- ฉบับหลัก
- ฉบับเพิ่มเติม
- ฉบับย่อ
*การสร้าง eReport ให้
ดำเนินการตามคู่มือการ
จัดส่งรายงาน EIA

กรอกข้อมูลรายงานใน
ระบบ
- ฉบับหลัก
- ฉบับแก้ไขเพิ่มเติม
- ฉบับย่อ (ถ้ามี)
*การกรอกข้อมูลให้
ดำเนินการตามคู่มือการ
ใช้งานระบบการจัดส่ง
รายงาน EIA
**ไม่ต้องอัปโหลดไฟล์
รายงาน

     

ได้รับความเห็นชอบ - ฉบับสมบูรณ์ฉบับหลัก 
1 ฉบับ
- ฉบับสมบูรณ์ย่อ 
1 ฉบับ

1 ชุด ประกอบด้วยไฟล์
ดังนี้
- ฉบับสมบูรณ์ฉบับหลัก 
- ฉบับสมบูรณ์ย่อ 
- ฉบับสมบูรณ์ที่ปกปิด
ข้อมูลส่วนบุคคล
- ฉบับสมบูรณ์เรียงลำดับ
ฉบับหลัก/แก้ไขเพิ่มเติม/
ฉบับย่อ (ถ้ามี) ตามลำดับ
การพิจารณา
*การสร้าง eReport ให้
ดำเนินการตามคู่มือการ
จัดส่งรายงาน EIA

- กรอกข้อมูลรายงาน
ฉบับสมบูรณ์
- อัปโหลดไฟล์รายงาน
ฉบับสมบูรณ์ฉบับหลักที่
ปกปิดข้อมูลส่วนบุคคล
*การกรอกข้อมูล/อัป
โหลดไฟล์ ให้ดำเนินการ
ตามคู่มือการใช้งาน
ระบบฐานข้อมูล
รายงาน EIA

- ฉบับสมบูรณ์ฉบับหลัก
1 ฉบับ

1 ชุด ประกอบด้วยไฟล์
ดังนี้
- ฉบับสมบูรณ์ฉบับหลัก 
- ฉบับสมบูรณ์ฉบับหลัก
ที่ปกปิดข้อมูลส่วนบุคคล
- ฉบับสมบูรณ์เรียงลำดับ
ฉบับหลัก/แก้ไขเพิ่มเติม
ตามลำดับการพิจารณา
*การสร้าง eReport ให้
ดำเนินการตามคู่มือการ
จัดส่งรายงาน EIA
**การปกปิดข้อมูลส่วน
บุคคลให้ดำเนินการตาม
แนวทางการเปิดเผย
ข้อมูลในรายงานการ
ประเมินผลกระทบสิ่ง
แวดล้อมและรายงานผล
การปฏิบัติตามมาตรการ
ที่กำหนดไว้ในรายงาน
การประเมินผลกระทบ
สิ่งแวดล้อม สำหรับเผย
แพร่ให้ประชาชนเข้า
ตรวจดูได้ทางระบบ
อิเล็กทรอนิกส์

- กรอกข้อมูลรายงาน
ฉบับสมบูรณ์
- อัปโหลดไฟล์
รายงานฉบับสมบูรณ์
ที่ปกปิดข้อมูลส่วน
บุคคล
*การกรอกข้อมูล/
อัปโหลดไฟล์ ให้
ดำเนินการตามคู่มือ
การใช้งานระบบฐาน
ข้อมูลรายงาน EIA

หน้า 3

1.2
สรุปแนวทางการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม 

ตามประกาศ สผ. เรื่อง แนวทางการจัดส่งรายงานการประเมินผลกระทบ
สิ่งแวดล้อม พ.ศ. 2568



คชก.
ผู้พิจารณา

ขั้นตอนการ
พิจารณา

กรณีโครงการ กิจการ หรือการดำเนินการของหน่วยงานของรัฐ
หรือหน่วยงานของรัฐดำเนินการร่วมกับเอกชนที่ต้องเสนอขอรับความเห็น

ชอบจากคณะรัฐมนตรี (เสนอ คชก. และ กก.วล.)

กรณีโครงการกิจการ หรือการดำเนินการ ที่ต้องได้รับอนุญาตตามกฎหมาย
หรือไม่ต้องเสนอขอรับความเห็นชอบจากคณะรัฐมนตรี 

(เสนอ คชก. / ไม่ต้องเสนอ กก.วล.)

รูปแบบเอกสาร
รูปแบบไฟล์

อิเล็กทรอนิกส์
ส่งผ่านระบบ 

Smart EIA Plus รูปแบบเอกสาร
รูปแบบไฟล์

อิเล็กทรอนิกส์
ส่งผ่านระบบ 

Smart EIA Plus

คชก. จังหวัด
 

 

ขั้นเสนอ คชก. ส่งรายงานให้ สผ.
เพื่อดำเนินการ ดังนี้
- ต้นฉบับหลัก 1 ฉบับ
- ต้นฉบับย่อ 1 ฉบับ

ส่งรายงานให้ กทม./
จังหวัด ดังนี้
- สำเนาฉบับหลัก 
1 ฉบับ
- สำเนาฉบับย่อ 1 ฉบับ
- ต้นฉบับแก้ไขเพิ่มเติม 
1 ฉบับ
- สำเนาฉบับแก้ไขเพิ่มเติม
1 ฉบับ

1 ชุด ส่งให้ สผ.
ประกอบด้วยไฟล์ ดังนี้
- ฉบับหลัก
- ฉบับย่อ

1 ชุด ส่งให้ กทม./
จังหวัด ประกอบด้วย
ไฟล์ ดังนี้
- ฉบับหลัก
- ฉบับแก้ไขเพิ่มเติม
- ฉบับย่อ 
*การสร้าง eReport
 ให้ดำเนินการตามคู่มือ
การจัดส่งรายงาน EIA

กรอกข้อมูลรายงานใน
ระบบ
- ฉบับหลัก
- ฉบับแก้ไขเพิ่มเติม
- ฉบับย่อ (ถ้ามี)
*การกรอกข้อมูลให้
ดำเนินการตามคู่มือการ
ใช้งานระบบฐานข้อมูล
รายงาน EIA
**ไม่ต้องอัปโหลดไฟล์
รายงาน

ส่งรายงานให้ สผ.
  เพื่อดำเนินการ ดังนี้
- ต้นฉบับหลัก 1 ฉบับ

ส่งรายงานให้ กทม./จังหวัด
ดังนี้
- สำเนาฉบับหลัก 1 ฉบับ
- ต้นฉบับแก้ไขเพิ่มเติม
1 ฉบับ
- สำเนาฉบับแก้ไขเพิ่ม
เติม 1 ฉบับ

1 ชุด ส่งให้ สผ. ประกอบ
ด้วยไฟล์ ดังนี้
- ต้นฉบับหลัก

1 ชุด ส่งให้ กทม./จังหวัด
ประกอบด้วยไฟล์ ดังนี้
- ฉบับหลัก/แก้ไขเพิ่มเติม
*การสร้าง eReport
 ให้ดำเนินการตามคู่มือ
การจัดส่งรายงาน EIA

กรอกข้อมูลรายงาน
- ฉบับหลัก/เพิ่มเติม
*การกรอกข้อมูลให้
ดำเนินการตามคู่มือการ
ใช้งานระบบฐานข้อมูล
รายงาน EIA 
**ไม่ต้องอัปโหลดไฟล์
รายงาน

ขั้นเสนอ กก.วล.  ส่งรายงานให้จังหวัด/
กทม. ดังนี้
- ต้นฉบับหลัก 1 ฉบับ
- สำเนาฉบับหลัก 1 ฉบับ
- ต้นฉบับแก้ไขเพิ่มเติม 
1 ฉบับ
- สำเนาฉบับแก้ไขเพิ่มเติม
1 ฉบับ
- ต้นฉบับย่อ 1 ฉบับ
- สำเนาฉบับย่อ 1 ฉบับ

1 ชุด ส่งรายงานให้
จังหวัด/กทม. ประกอบ
ด้วยไฟล์ ดังนี้
- ฉบับหลัก
- ฉบับเพิ่มเติม
- ฉบับย่อ
*การสร้าง eReport
ให้ดำเนินการตามคู่มือ
การจัดส่งรายงาน EIA

กรอกข้อมูลรายงานใน
ระบบ
- ฉบับหลัก
- ฉบับแก้ไขเพิ่มเติม
- ฉบับย่อ (ถ้ามี)
*การกรอกข้อมูลให้
ดำเนินการตามคู่มือการ
ใช้งานระบบฐานข้อมูล
รายงาน EIA
**ไม่ต้องอัปโหลดไฟล์
รายงาน

     

ได้รับความเห็นชอบ ส่งรายงานให้ สผ. ดังนี้
- ฉบับสมบูรณ์ฉบับหลัก 
1 ฉบับ
- ฉบับสมบูรณ์ย่อ 1 ฉบับ

1 ชุด ส่งให้ สผ.
ประกอบด้วยไฟล์ ดังนี้
- ฉบับสมบูรณ์ฉบับหลัก 
- ฉบับสมบูรณ์ย่อ
- ฉบับสมบูรณ์ที่ปกปิด
ข้อมูลส่วนบุคคล 
- ฉบับสมบูรณ์เรียง
ลำดับฉบับหลัก/แก้ไข
เพิ่มเติม /ฉบับย่อ (ถ้ามี)
ตามลำดับการพิจารณา

1 ชุด ส่งให้ กทม./
จังหวัด ประกอบด้วย
ไฟล์ ดังนี้
- ฉบับสมบูรณ์ฉบับหลัก 
- ฉบับสมบูรณ์ย่อ 
- ฉบับสมบูรณ์ฉบับหลัก
ที่ปกปิดข้อมูลส่วนบุคคล
- ฉบับสมบูรณ์เรียง
ลำดับฉบับหลัก/แก้ไข
เพิ่มเติม/ฉบับย่อ (ถ้ามี)
ตามลำดับการพิจารณา
*การสร้าง eReport ให้
ดำเนินการตามคู่มือ
การจัดส่งรายงาน EIA

- กรอกข้อมูลรายงาน
ฉบับสมบูรณ์
- อัปโหลดไฟล์รายงาน
ฉบับสมบูรณ์ฉบับหลักที่
ปกปิดข้อมูลส่วนบุคคล
*การกรอกข้อมูล/การอัป
โหลดไฟล์ให้ดำเนินการ
ตามคู่มือการใช้งาน
ระบบฐานข้อมูลรายงาน
EIA

ส่งรายงานให้ สผ. ดังนี้
- ฉบับสมบูรณ์ฉบับหลัก 
1 ฉบับ

1 ชุด ส่งให้ สผ. ประกอบ
ด้วยไฟล์ ดังนี้
- ฉบับสมบูรณ์ฉบับหลัก 
ฉบับสมบูรณ์ฉบับหลักที่
ปกปิดข้อมูลส่วนบุคคล
- ฉบับสมบูรณ์เรียงลำดับ
ฉบับหลัก/แก้ไขเพิ่มเติม
ตามลำดับการพิจารณา

1 ชุด ส่งให้ กทม./จังหวัด
ประกอบด้วยไฟล์ ดังนี้
- ฉบับสมบูรณ์ฉบับหลัก 
- ฉบับสมบูรณ์ที่ปกปิด
ข้อมูลส่วนบุคคล
- ฉบับสมบูรณ์เรียงลำดับ
ฉบับหลัก/แก้ไขเพิ่มเติม
ตามลำดับการพิจารณา
*การสร้าง eReport
 ให้ดำเนินการตามคู่มือ
การจัดส่งรายงาน EIA
**การปกปิดข้อมูลส่วน
บุคคลให้ดำเนินการตาม
แนวทางการเปิดเผย
ข้อมูลในรายงานการ
ประเมินผลกระทบ
สิ่งแวดล้อมและรายงาน
ผลการปฏิบัติตาม
มาตรการที่กำหนดไว้ใน
รายงานการประเมินผลก
ระทบสิ่งแวดล้อม สำหรับ
เผยแพร่ให้ประชาชนเข้า
ตรวจดูได้ทางระบบ
อิเล็กทรอนิกส์

- กรอกข้อมูลรายงาน
ฉบับสมบูรณ์
- อัปโหลดไฟล์รายงาน
ฉบับสมบูรณ์ที่ปกปิด
ข้อมูลส่วนบุคคล
*การกรอกข้อมูล/อัป
โหลดไฟล์ให้ดำเนินการ
ตามคู่มือการใช้งาน
ระบบฐานข้อมูล
รายงาน EIA

สรุปแนวทางการจัดส่งรายงานการประเมินผลกระทบสิ่งแวดล้อม 
ตามประกาศ สผ. เรื่อง แนวทางการจัดส่งรายงานการประเมินผลกระทบ

สิ่งแวดล้อม พ.ศ. 2568
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ผู้ดำเนินการ/ผู้ขออนุญาต

เสนอรายงานฯ

เจ้าหน้าที่ซึ่งมีอำนาจอนุญาต

สผ.

รอสั่งการอนุญาต

รายงานไม่ถูกต้องตามหลักเกณฑ์
วิธีการ และเงื่อนไขที่กำหนด หรือ

เอกสารไม่ครบถ้วน

สผ. ตรวจสอบรายงานฯ  (15 วัน)

รายงานฯ ถูกต้องตามหลักเกณฑ์ วิธีการ และ
เงื่อนไขที่กำหนด และเอกสารครบถ้วน

คชก. พิจารณา
(45 วัน)

ผู้ดำเนินการ/
ผู้ขออนุญาต

ส่งรายงานฉบับสมบูรณ์
ภายใน 45 วัน

เจ้าหน้าที่ซึ่งมีอำนาจอนุญาต
นำมาตรการที่เสนอในรายงานฯ

ไปกำหนดเป็นเงื่อนไขใน
การสั่งอนุญาต

สผ. พิจารณาเสนอความเห็นเบื้องต้น (15 วัน)

ไม่ให้ความเห็นชอบ

เสนอรายงาน ฉบับแก้ไขเพิ่มเติม/
ฉบับใหม่ (180 วัน)

คชก. พิจารณา (30 วัน)

ไม่ให้ความเห็นชอบ

จบกระบวนการพิจารณารายงานฯ กรณีไม่เห็นด้วยกับความเห็นของ คชก. 
มีสิทธินำคดีไปสู่ศาลปกครอง ภายใน 90 วัน

หมายเหตุ : *รูปแบบรายงานที่ส่งให้เจ้าหน้าที่ซึ่งมีอำนาจอนุญาต ให้เป็นไปตามหลักเกณฑ์และเงื่อนไขที่หน่วยงานอนุญาตกำหนด
                   **ระยะเวลา 5 ปี นับแต่วันที่ สผ. หรือหน่วยงานของรัฐตามที่ กก.วล. มอบหมายให้ปฏิบัติหน้าที่แทน ได้มีหนังสือแจ้งความเห็นชอบของ คชก.      
                       ซึ่งเป็นไปตามมาตรา 51/6 แห่งพระราชบัญญัติส่งเสริมและรักษาคุณภาพสิ่งแวดล้อมแห่งชาติ (ฉบับที่ 2) พ.ศ. 2561
                  ***รายงานฉบับสมบูรณ์ ฉบับปกปิดที่จะนำไปอัปโหลดในระบบ Smart EIA Plus ไม่ต้องดำเนินการสร้างสารบัญที่มีลิงก์ และการเชื่อมลิงก์ระหว่างหน้า

มีสิทธิเสนอรายงานฯ ฉบับใหม่ 
เข้าสู่กระบวนการพิจารณา

ผู้ดำเนินการ/ผู้ขออนุญาต

เสนอรายงานฯ
ประกอบการพิจารณา
อนุญาต ภายใน 5 ปี**

อัพโหลดไฟล์ในระบบ Smart EIA Plus

เจ้าหน้าที่ตรวจสอบความครบถ้วน

เผยแพร่ในระบบ Smart EIA Plus

ครบถ้วน

ไม่ครบถ้วน

  ฉบับสมบูรณ์ฉบับหลัก   +  ไฟล์ 1 ชุด
              1 ฉบับ   
 

ต้นฉบับหลัก 1 ฉบับ + ไฟล์ 1 ชุด  

ฉบับสมบูรณ์ฉบับหลัก
ฉบับเรียงลำดับ
ฉบับปกปิด

สำเนา 1 ฉบับ*

สรุปการส่งรายงานในแต่ละขั้นตอน 
กรณีโครงการหรือกิจการหรือการดำเนินการของเอกชน ที่ต้องได้รับอนุญาตตามกฎหมาย

หรือหน่วยงานรัฐ ที่ไม่ต้องเสนอขอรับความเห็นชอบจากคณะรัฐมนตรี 
หรือไม่ต้องได้รับอนุญาตตามกฎหมาย 

ต้นฉบับแก้ไข 1 ฉบับ + ไฟล์ 1 ชุด
     เพิ่มเติม  

ต้นฉบับแก้ไข  1 ฉบับ
       เพิ่มเติม

สำเนาฉบับ     1 ฉบับ
แก้ไขเพิ่มเติม

สำเนาฉบับหลัก 1 ฉบับ + ไฟล์ 1 ชุด

ส่งให้ สผ.

ส่งให้ กทม./จังหวัด.

  + ไฟล์ 1 ชุด  

ส่งให้ สผ.

+ ไฟล์ 1 ชุด 

ประกอบด้วยประกอบด้วย
ฉบับสมบูรณ์ฉบับหลัก
ฉบับเรียงลำดับ
ฉบับปกปิด

ส่งให้ สผ. ส่งให้ กทม./จังหวัด

เส
นอ

 ค
ชก

. ส่
วน

กล
าง

เส
นอ

 ค
ชก

. จั
งห

วัด ส่งให้ สผ..
ต้นฉบับหลัก 1 ฉบับ + ไฟล์ 1 ชุด  

เส
นอ

 ค
ชก

. ส่
วน

กล
าง

เส
นอ

 ค
ชก

. จั
งห

วัด ส่งให้ กทม./จังหวัด
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เห็นชอบ



เสนอรายงานฯ ต่อ สผ.

คณะรัฐมนตรี

คชก. พิจารณา

สผ. สรุปความเห็นของ คชก.

ข้อมูลไม่เพียงพอ

ข้อมูลเพียงพอให้เสนอ กก.วล.

หน่วยงานของรัฐ หรือหน่วยงานของรัฐ
ร่วมกับเอกชน

แก้ไขรายงานฯ

กก.วล. เสนอความเห็น

ส่งรายงานฉบับสมบูรณ์
ภายใน 45 วัน

หน่วยงานของรัฐ หรือหน่วยงานของรัฐ
ร่วมกับเอกชน

คณะรัฐมนตรีอาจขอให้บุคคล/สถาบัน
ทำการศึกษา และเสนอรายงาน หรือ
ความเห็นเพื่อประกอบการพิจารณา

พิจารณา

หมายเหตุ : * ระยะเวลา 5 ปี นับแต่วันที่ สผ. หรือหน่วยงานของรัฐตามที่ กก.วล. มอบหมายให้ปฏิบัติหน้าที่แทน ได้มีหนังสือแจ้งความเห็นชอบของ กก.วล.    
                     ซึ่งเป็นไปตามมาตรา 51/6 แห่งพระราชบัญญัติส่งเสริมและรักษาคุณภาพสิ่งแวดล้อมแห่งชาติ (ฉบับที่ 2) พ.ศ. 2561
                ** รายงานฉบับสมบูรณ์ ฉบับปกปิดที่จะนำไปอัปโหลดในระบบ Smart EIA Plus ไม่ต้องดำเนินการสร้างสารบัญที่มีลิงก์ และการเชื่อมลิงก์ระหว่างหน้า

หน่วยงานของรัฐ หรือหน่วย
งานของรัฐร่วมกับเอกชน

จัดทำรายงานฯตั้งแต่ในระยะ
ทำการศึกษาความเหมาะสมของ

โครงการฯ

 คชก. : คณะกรรมการผู้ชำนาญการ     
 กก.วล. :  คณะกรรมการสิ่งแวดล้อมแห่งชาติ

เสนอรายงานฯ 
เพื่อขอรับความเห็นชอบจาก
คณะรัฐมนตรี ภายใน 5 ปี *

สรุปการส่งรายงานในแต่ละขั้นตอน 
กรณีโครงการหรือกิจการ หรือดำเนินการของหน่วยงานของรัฐ หรือหน่วยงานของรัฐร่วมกับเอกชน

ที่ต้องเสนอขอรับความเห็นชอบจากคณะรัฐมนตรี

ต้นฉบับหลัก 1 ฉบับ
ต้นฉบับย่อ 1 ฉบับ 

ฉบับหลัก
ฉบับย่อ
ฉบับเรียงลำดับ
ฉบับปกปิด

อัปโหลดไฟล์ในระบบ Smart EIA Plus

เจ้าหน้าที่ตรวจสอบความครบถ้วน

เผยแพร่ในระบบ Smart EIA Plus

ครบถ้วน

ไม่ครบถ้วน

+     ไฟล์ 1 ชุด 

สำเนาฉบับหลัก 1 ฉบับ 
สำเนาฉบับย่อ 1 ฉบับ

ส่งให้ สผ.

+    ไฟล์ 1 ชุด  

ส่งให้ กทม./จังหวัด.

ต้นฉบับแก้ไข    1 ฉบับ
      เพิ่มเติม

สำเนาฉบับ        1 ฉบับ
      แก้ไขเพิ่มเติม

ต้นฉบับย่อ        1 ฉบับ 
สำเนาฉบับย่อ  1 ฉบับ

+  ไฟล์ 1 ชุด 

 ประกอบด้วย

ต้นฉบับหลัก 1 ฉบับ  
ต้นฉบับย่อ 1 ฉบับ  

+ ไฟล์ 1 ชุด 

ต้นฉบับแก้ไข   1 ฉบับ
เพิ่มเติม 
ต้นฉบับย่อ      1 ฉบับ 

+  ไฟล์ 1 ชุด 

+ ไฟล์ 1 ชุด 

 ประกอบด้วย
ฉบับหลัก
ฉบับย่อ
ฉบับเรียงลำดับ
ฉบับปกปิด

ส่งให้ กทม./จังหวัด.ส่งให้ สผ.

ต้นฉบับหลัก 1 ฉบับ
สำเนาฉบับหลัก 1 ฉบับ
ต้นฉบับแก้ไขเพิ่มเติม 1 ฉบับ
สำเนาฉบับแก้ไขเพิ่มเติม 1 ฉบับ
ต้นฉบับย่อ 1 ฉบับ
สำเนาฉบับย่อ 1 ฉบับ

+     ไฟล์ 1 ชุด 

ส่งให้ สผ.

ส่งให้ สผ.
ต้นฉบับหลัก 1 ฉบับ
ต้นฉบับย่อ 1 ฉบับ +    ไฟล์ 1 ชุด 

เส
นอ

 ค
ชก

. ส่
วน

กล
าง

เส
นอ

 ค
ชก

. จั
งห

วัด

เส
นอ

 ค
ชก

. จั
งห

วัด
เส

นอ
 ค

ชก
. ส่

วน
กล

าง

ส่งให้ สผ.

ส่งให้ กทม./จังหวัด
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**

ต้นฉบับหลัก 1 ฉบับ
สำเนาฉบับหลัก 1 ฉบับ
ต้นฉบับแก้ไขเพิ่มเติม 1 ฉบับ
สำเนาฉบับแก้ไขเพิ่มเติม 1 ฉบับ
ต้นฉบับย่อ 1 ฉบับ
สำเนาฉบับย่อ 1 ฉบับ

+     ไฟล์ 1 ชุด 

ส่งให้ กทม./จังหวัด.



ขั้นตอนและวิธี
การสร้างรายงานในรูปแบบอิเล็กทรอนิกส์

2
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4 องค์ประกอบหลัก

ความสอดคล้องของเนื้อหาในเอกสารต้นฉบับ
และไฟล์รายงานอิเล็กทรอนิกส์ (e-Report)

01.
รายละเอียดเนื้อหาของรายงานการประเมินผลกระทบสิ่งแวดล้อม
ในรูปแบบไฟล์อิเล็กทรอนิกส์ต้องสอดคล้องกับเอกสารรายงานฯ
ต้นฉบับทั้งส่วนของข้อความ รูปภาพและตาราง

การสร้างสารบัญที่มีลิงก์ และการเชื่อมลิงก์
ระหว่างหน้า03.

1) หน้าปกลิงก์ : จัดทำลิงก์ในส่วนหน้าปกให้สามารถลิงก์ไปยังหน้าสารบัญได้
เช่น การสร้างข้อความ “ไปยังสารบัญ >>” ที่หน้าปก และใส่ลิงก์ไปยังหน้า
สารบัญ เป็นต้น
2) สารบัญที่มีลิงก์ : จัดทำลิงก์ในทุกหัวข้อย่อยเพื่อสามารถดูส่วนเนื้อหาที่
เกี่ยวข้องได้อย่างรวดเร็ว และในแต่ละหน้าของหัวข้อย่อยต้องสร้างลิงก์มายัง
หน้าสารบัญ เพื่อให้สามารถย้อนกลับไปยังหน้าสารบัญได้ทันที ศึกษาขั้น
ตอนเพิ่มเติมได้ที่หน้าที่ 9-12
3) ภาคผนวก : สร้างสารบัญภาคผนวกหรือตารางสรุปรายการเอกสารภาค
ผนวก ที่สามารถลิงก์ไปยังหน้าเอกสารภาคผนวกที่ต้องการเรียกดูทันที

การจัดเรียงเล่มรายงานฯ02.

โปรแกรมถูกลิขสิทธิ์04.
ใช้โปรแกรมจัดทำไฟล์รายงานอิเล็กทรอนิกส์ (e-Report)
ในรูปแบบไฟล์ PDF เช่น โปรแกรม Adobe Acrobat Pro
ที่เป็นมาตรฐานเดียวกันและถูกต้องตามลิขสิทธิ์   

ของรายงานในรูปแบบอิเล็กทรอนิกส์ (e-Report)

1) รูปภาพและตารางในรายงานฯ ต้องจัดวางในลักษณะที่สามารถ
อ่านได้ในแนวตั้ง
2) สารบัญ ต้องประกอบด้วย สารบัญหลัก (หัวข้อหลักและหัวข้อย่อย)
สารบัญตาราง และสารบัญภาพ

หมายเหตุ : หากเนื้อหาถูกจัดทำในแนวนอน กรุณาจัดไฟล์ให้อยู่ในรูปแบบแนวตั้ง เพื่อให้
สามารถอ่านได้สะดวกโดยไม่ต้องพลิกหรือเอียงหน้า

หน้า 8
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ใช้ Styles ใน Word เช่น Heading 1, Heading 2 เป็นต้น
สำหรับหัวข้อที่ต้องการให้ปรากฏในสารบัญ

2

1

2.2

4

Word จะสร้างลิงก์อัตโนมัติให้ เมื่อคุณคลิกหัวข้อ
ในสารบัญ จะนำไปยังส่วนที่เกี่ยวข้องในเอกสาร

วางเคอร์เซอร์ในตำแหน่งที่ต้องการใส่สารบัญไปที่แท็บ
References และเลือก Table of Contents เลือกรูปแบบ
สารบัญที่ต้องการ โดยสามารถเลือก Custom Table of
Contents เพื่อปรับแต่งเพิ่มเติมได้

ไปที่แท็บ File > Save As
เลือกประเภทไฟล์เป็น PDF
คลิก Options และตรวจสอบให้แน่ใจว่ามีการเลือก Create bookmarks using
headings (ถ้ามี) จากนั้นบันทึกไฟล์

จัดรูปแบบหัวข้อ

3

แทรกสารบัญ

ลิงก์ในสารบัญ

บันทึกเป็น PDF พร้อมลิงก์

การสร้างลิงก์แบบกำหนดเอง

คลุมข้อความที่ต้องการทำลิงก์
คลิกขวาและเลือก Hyperlink หรือไปที่แท็บ Insert > Link
ในหน้าต่าง Insert Hyperlink ให้เลือก Place in This Document
เลือกหัวข้อที่ต้องการลิงก์ไป
คลิก OK

การสร้างลิงก์ไปยังตำแหน่งในเอกสาร กรณีอื่นๆ เช่น การสร้างลิงก์
จากหน้าเนื้อหากลับมายังสารบัญ เป็นต้น 
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การสร้างลิงก์ในโปรแกรม การสร้างลิงก์ในโปรแกรม  WORD WORDขั้นตอน ขั้นตอน 
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การสร้างลิงก์ในโปรแกรม การสร้างลิงก์ในโปรแกรม  WORD WORD

วางเคอร์เซอร์ในตำแหน่งที่ต้องการเพิ่มสารบัญตาราง
ไปที่แท็บ References > เลือก Insert Table of Figures 
ในหน้าต่างที่เปิดขึ้นตั้งค่า Caption label เป็น Table
คลิก OK
Word จะสร้างสารบัญตารางอัตโนมัติพร้อมลิงก์ไปยัง
ตำแหน่งของตาราง

การแทรกสารบัญตาราง (LIST OF TABLES)

   1. การตั้งค่าคำอธิบายใต้ภาพ/ตาราง (Captions)
เพิ่มคำอธิบาย (Caption) ให้กับภาพและตาราง1.

คลิกขวาที่ภาพหรือตาราง > เลือก Insert Caption
ในหน้าต่างที่เปิดขึ้น :

เปลี่ยน Label เป็น Table (สำหรับตาราง) หรือ Figure (สำหรับภาพ)
เพิ่มข้อความคำอธิบาย เช่น "Table 1 : รายละเอียดข้อมูล" หรือ "Figure 1 : กราฟแสดงผล"

กด OK
ปรับรูปแบบคำอธิบาย (Caption)2.

หากต้องการให้ Caption มีรูปแบบเฉพาะ เช่น ตัวหนา หรือเพิ่มระยะห่าง :
ไปที่แท็บ Home > Styles
คลิกขวาที่ Style ชื่อ Caption > เลือก Modify เพื่อปรับแต่งรูปแบบ

ขั้นตอนการสร้างสารบัญตารางและสารบัญภาพใน Word

วางเคอร์เซอร์ในตำแหน่งที่ต้องการเพิ่มสารบัญภาพ
ไปที่แท็บ References > เลือก Insert Table of
Figures
ในหน้าต่างที่เปิดขึ้นตั้งค่า Caption label เป็น Figure
คลิก OK
Word จะสร้างสารบัญภาพอัตโนมัติพร้อมลิงก์ไปยัง
ตำแหน่งของภาพ

 การแทรกสารบัญภาพ (LIST OF FIGURES)

หน้า 10
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เปิดไฟล์ PDF ด้วย Adobe Acrobat Pro (ไม่ใช่ Acrobat
Reader ซึ่งเป็นเวอร์ชันฟรี)

2

เลือกข้อความในสารบัญที่ต้องการทำลิงก์
คลิกขวาและเลือก Create Link หรือใช้คำสั่ง Add/Edit Web or Document Link ในเมนู
เลือก Link Type เป็น "Invisible Rectangle" (แนะนำ) หรือเลือกแบบอื่นตามความ
ต้องการ
ในส่วน Action ให้เลือก Go to a Page View คลิกปุ่ม Next และเลื่อนหน้าไปยังส่วนที่
ต้องการลิงก์ จากนั้นกด Set Link

ไปที่เมนู Edit PDF ในแถบเครื่องมือ

เปิดไฟล์ PDF1

3

สร้างข้อความที่ต้องการลิงก์ไปสารบัญ เช่น
“ไปยังสารบัญ >>”
สร้างลิงก์โดยเลือกข้อความที่สร้าง และ

      ทำตามขั้นตอนการสร้างลิงก์ในข้อ 3

เข้าสู่โหมดแก้ไข

สร้างลิงก์ในสารบัญ

การสร้างลิงก์และข้อความใหม่แบบกำหนดเอง

ขั้นตอนการสร้างลิงก์ในโปรแกรม ขั้นตอนการสร้างลิงก์ในโปรแกรม 
 Adobe Acrobat Pro Adobe Acrobat Pro
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PDF-XChange Editor (ฟรีหรือเวอร์ชัน Pro)

Foxit PDF Editor

เปิดไฟล์ PDF
ใช้เครื่องมือ Link Tool เพื่อสร้างลิงก์
กำหนดให้ลิงก์เชื่อมโยงกับหน้าหรือที่อยู่ในเอกสาร
บันทึกไฟล์

เครื่องมือออนไลน์

PDF อื่น ๆ หรือเครื่องมือออนไลน์PDF อื่น ๆ หรือเครื่องมือออนไลน์
2.4ขั้นตอนการสร้างลิงก์ในโปรแกรม ขั้นตอนการสร้างลิงก์ในโปรแกรม 

เปิดไฟล์ PDF ในโปรแกรม
เลือกเมนู Link Tool
คลิกลากเพื่อสร้างพื้นที่ลิงก์รอบข้อความในสารบัญ
กำหนดลิงก์ให้ไปยังหน้าหรือจุดที่ต้องการในไฟล์
บันทึกไฟล์

หากไม่มีโปรแกรม Adobe Acrobat Pro :
ใช้เครื่องมือออนไลน์ เช่น Sejda, PDFescape, หรือ iLovePDF
อัปโหลดเอกสาร PDF
สร้างสารบัญหรือเพิ่มลิงก์ด้วยเครื่องมือที่มีให้

หน้า 12

จุดเน้นย้ำจุดเน้นย้ำ

1. ความคมชัดของรูป/ตาราง/แบบแปลน/เอกสารประกอบ ที่เพียงพอสำหรับ
การพิจารณารายงานหรือแสดงให้เห็นข้อมูลที่จำเป็นที่ต้องการนำเสนอ
2. หลีกเลี่ยงการสแกนเอกสาร ซึ่งทำให้ความคมชัดน้อยลง โดยอนุโลมให้เฉพาะ
ข้อมูลที่จำเป็นต้องสแกนเท่านั้น 

ข้อควรพิจารณาในการจัดทำรายงานในรูปแบบ
อิเล็กทรอนิกส์ (e-Report) มีดังนี้



การป้องกันการแก้ไขการป้องกันการแก้ไข

วิธีป้องกันการแก้ไขไฟล์ PDF ด้วย Adobe Acrobat Pro
 เปิดไฟล์ PDF ใน Adobe Acrobat Pro1.

คลิก File > Open แล้วเลือกไฟล์ PDF ที่ต้องการป้องกัน
 เข้าสู่เมนูการตั้งค่าความปลอดภัย2.

ไปที่ File > Protect Using Password หรือ
ไปที่แท็บ Tools > Protect > Encrypt > Encrypt with Password

 ตั้งค่ารหัสผ่าน3.
เลือก Permissions Password (รหัสผ่านสำหรับการป้องกันการแก้ไข)
ใส่รหัสผ่านที่ต้องการในช่องที่กำหนด

 ตั้งค่าข้อจำกัด (Permissions)4.
ในหน้าต่าง Security Settings :

เลือก Restrict editing and printing of the document
ปรับสิทธิ์ เช่น ห้ามแก้ไขหรือห้ามพิมพ์

กด OK
บันทึกไฟล์5.

บันทึกไฟล์ PDF โดยไปที่ File > Save As เพื่อให้การตั้งค่ามีผล

PDFPDF

การตั้งค่าปกป้องไฟล์
หน้า 13
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ไฟล์ไฟล์



จัดทำและเผยแพร่โดย

กองพัฒนาระบบการประเมินผลกระทบสิ่งแวดล้อม
สำนักงานนโยบายและแผนทรัพยากรธรรมชาติและสิ่งแวดล้อม
อาคารทิปโก้ทาวเวอร์ 2 เลขที่ 118/1 ถนนพระรามที่ 6 แขวงพญาไท
เขตพญาไท กรุงเทพฯ 10400

ที่ปรึกษา

นายจิรวัฒน์ ระติสุนทร
รองเลขาธิการ
สำนักงานนโยบายและแผนทรัพยากรธรรมชาติและสิ่งแวดล้อม

นางสาวรุ่งอรุณ ญาติบรรทุง
ผู้อำนวยการกองพัฒนาระบบการประเมินผลกระทบสิ่งแวดล้อม

ผู้จัดทำ

นางพรรณนิภา สืบสิงห์                   ผู้อำนวยการกลุ่มงานวิชาการและฐานข้อมูล
นางสาวจุฑาภรณ์ ทองสอดแสง      นักวิชาการสิ่งแวดล้อมชำนาญการ
นางสาวกรรณิการ์ สรกล                 นักวิชาการสิ่งแวดล้อมปฏิบัติการ



กองพัฒนาระบบการประเมินผลกระทบสิ่งแวดล้อม
สำนักงานนโยบายและแผนทรัพยากรธรรมชาติและสิ่งแวดล้อม

โทรศัพท์ 02 265 6500 ต่อ 6858 หรือ 02 265 6640


